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Terms of Use 
 
This release of Contact Manager, hereafter referred to as the Software, has been expressly 
created to support the Amateur Radio DMR community, and is not designed for commercial 
application. Although the software is available for free download, it is not freeware! Amateur 
Radio users are granted an indefinite license to use the Software, subject to the terms below. 
Commercial users must contact us before using the Software. 
 
By installing the Software on your computer, you automatically agree to the above, as well as 
the following: 
 
1. You agree not to distribute the Software in any form (including modified executable code) 

and by any means of reproduction (including but not limited to distributed cloud storage, 
storage area networks, and web sites) to any third party without express written 
permission from us. 

2. You agree not to disassemble or reverse-engineer the Software. 
3. There is no limit to the number of machines you may install the Software on, however, this 

practice shall not be carried out in any manner that violates the conditions above. 
4. You may not employ the Software as part of any service for which you receive 

remuneration, either directly or indirectly, without written permission from us.  
5. Amateur radio equipment dealers and resellers are permitted to use the Software to 

provide equipment buyers with working codeplugs (this practice promotes DMR by 
helping users to adopt this mode), however, no charge may be made for this service. 

6. You will make back-ups of all critical data sets prior to using the Software to work with 
them. 

Disclaimer 
 
The Software is provided 'as is' without warranty of any kind, either express or implied, 
including, but not limited to, the implied warranties of fitness for a purpose, or the warranty 
of non-infringement. Without limiting the foregoing, we make no warranty that the Software 
will meet your requirements, the service provided by the Software will be uninterrupted, 
timely, secure or error-free, the results that may be obtained from the use of the Software 
will be effective, accurate or reliable, the quality of the Software will meet your expectations, 
or that any errors in the Software will be corrected. 
 
The Software and its documentation could include technical or other mistakes, inaccuracies 
or typographical errors. We may make changes to the Software or documentation. We 
assume no responsibility for errors or omissions in the Software or its documentation. 
 
In no event shall we be liable to you or any third parties for any special, punitive, incidental, 
indirect or consequential damages of any kind, or any damages whatsoever, including, 
without limitation, those resulting from loss of use, data or profits, whether or not we have 
been advised of the possibility of such damages, and on any theory of liability, arising out of 
or in connection with the use of this Software. 
 
The use of the Software is done at your own discretion and risk and with agreement that you 
will be solely responsible for any damage to your computer system or loss of data that results 
from such activities. No advice or information, whether oral or written, obtained by you from 
us or from our web site shall create any warranty for the Software. 
 



Privacy Policy 
 
We respect the privacy of individuals. The Software contains no ad-ware, tracking devices, or 
any other hidden mechanisms that operate without the express permission of the user. The 
Software does not make any changes to your computer configuration. If you have downloaded 
the Software from any location other than our web site, we cannot guarantee that this will be 
true.
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1.0 Introduction 
 
NØGSG DMR Contact Manager is a custom-designed software package designed for use with 
Connect Systems CS700, CS701, CS750, CS751, CS800, CS801, Tytera MD380 series radios, 
TYT MD2017/9600, as well as other radios that employ either the RDT or RDB format. 
 
Contact Manager makes it easy to maintain channel, zone, contact and call group 
information in these radios. It is fully compatible with the DMR-MARC database system and 
allows instant codeplug updates from a wide variety of sources.  
 
The software supports channel editing, importing, and exporting, as well as zone 
management. Associated contact information is always imported right along with channels 
whenever it's needed - - so that your imported channels work right the first time! 
 
Codeplug contact and channel data can be freely exported to and from spreadsheets (CSV), 
as well as other codeplugs in the RDB and RDT formats. This allows contacts, channels, and 
zones to be freely moved between different types of codeplugs. Advanced edit, search, and 
sorting functions allow quick and easy visualization of codeplug contents.  
 
Contact Manager features direct connectivity to the DMR-MARC online database. Worldwide 
call and user information is instantly available, and directly importable into any codeplug.  
 
Contact Manager is a free-standing, complete program. It is not dependent upon Excel or 
other applications, and does not require them to operate. 
 
 
1.1 Installation 
 
To install the program, proceed as follows: 
 

1. Download the Contact Manger executable program from our website. Place it on your 
desktop, if desired. 
 
The program is fully self-contained and contains no additional components, such as 
DLL files. 
 

2. If you've installed the program on your desktop, simply double-click its icon to run it. 
If you installed it elsewhere, hold down the ALT key, and while continuing to hold 
the ALT key, left-click on the Contact Manager executable file, and drag it to your 
desktop. This will create a shortcut to the application. 

 
 
To remove the program from the computer, simply delete the Contact Manager executable 
file.  
 
Contact Manager does not make any changes to your computer's configuration, so you can 
remove it at any time with no ill effects. 
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1.2 User Interface 
 
Controller Manager has a standard Windows user interface as shown in Figure 1. Various 
controls appear on the interface depending upon the selected mode. 
 

 
 

Figure 1: Contact Manager User Interface 
 
There are four modes available in this version of the software. These modes are selected by 
clicking on each of the four tabs: 
 

• Contacts Mode: The program displays the contacts contained within the codeplug, 
and allows manipulation of this information. 
 

• Channels Mode: The channels within the codeplug are displayed and may be edited if 
desired. 
 

• Zones and Scan Lists Modes: The zones and scan lists within the codeplug are 
displayed and may be edited. 
 

• Group Lists Mode: This mode allows viewing and editing Group Lists. 
 
 
 IMPORTANT: None of the commands within Contact Manager will be operative until 

you load a valid codeplug by using "File --> Open Codeplug..." command, or clicking 
the Open Codeplug File... button. 
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At the top of the program window several key pieces of information are displayed: 
 

• Working Codeplug File: Contact Manager displays the full Windows pathname of the 
file you've opened. If the field is blank, no codeplug is loaded. 
 

• Radio Name: This is the text that is displayed by the CS700/CS701 upon power up. 
Many hams put their call sign in this field. It's limited to 16 characters. 
 
The Radio Name value has no effect on the operation of your radio, other than 
displaying when the radio is first powered up. You can freely edit this field. 
 

• Radio DMR-MARC ID Number: This is the unique, 24-bit global DMR-MARC global 
identifier for the radio. Once a valid codeplug has been opened, you can freely edit 
this field. 
 

• Radio Type: This is the model number of your radio. There are several different 
manufacturers providing radios that use the RDT codeplug format. This window 
identifies the vendor class for the current codeplug. The program will display 
"Unknown" if it can't identify the vendor data within a codeplug. 
 
Clicking the dropdown button will change the vendor ID information within the 
codeplug to a different vendor. This is only needed if you need to move codeplugs 
between radio vendors. Be aware that specific features of individual models are not 
supported in Contact Manager - - these are supported in the CPS for each specific 
vendor. You cannot change between codeplug families (RDT, RDT). 

 
 
 
 
 
 
 
 
 
 
TIP: If you are generating a distinct, new codeplug from a master template, you can easily do 
this as follows: 
 

• Load the master codeplug. 
• Make the necessary changes to the codeplug within Contact Manager. 
• Under the File menu, choose "Save As..." (F12 key) to save the codeplug under a new 

filename. 
 

IMPORTANT: If you're creating a codeplug template to be shared by others (such as 
within a radio club), don't forget to update the RADIO NAME and DMR-MARC ID 
fields for each individual unit. Otherwise you'll have multiple units with the same 
identity, which can be very confusing! 
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1.3 Document Persistence 
 
Like most Windows applications, Contact Manager treats codeplugs as working documents 
and tracks the changes you've made to them. If you attempt to close a codeplug, open a new 
codeplug, or exit the program after making changes, you'll see the following dialog: 
 
 

 
 
 
When this dialog appears, you have three options: 
 

• Click YES to save the changes to the working codeplug and proceed with the 
operation you've selected. 
 

• Click NO to discard the changes to the working codeplug and proceed with the next 
command. 
 

• Click CANCEL to retain the codeplug in memory and cancel the command you've 
issued. 
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2.0 Viewing and Editing Contacts 
 
 
Contact Manager supports a wide variety of operations with the contacts contained in 
codeplugs. These include: 
 

• Viewing and sorting contacts according to any field. 
 

• Editing information in individual contacts. 
 

• Deleting and inserting contacts. 
 

• Importing and exporting contacts from Comma Separated Value (CSV) text files, 
which can be generated and read by most spreadsheet software. 
 

• Importing new contacts from the DMR-MARC worldwide DMR user database. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.1 Loading a Codeplug 
 
Prior to performing any operations on a codeplug, it must first be loaded into Contact 
Manager. This can be done in two ways: 
 

• Under the File menu, choose "Open Codeplug..." and select the file you want to open. 
• Click the Open Codeplug File... button, and select the file. 

 
Only valid RDT and RDB files can be opened. If there is a problem with the file, Contact 
Manager will display the following dialog box: 
 

 
 

IMPORTANT: You should be aware that a very compact, relational database 
structure is used within each codeplug. In this structure, contact, channel, zone, and 
other data are interrelated and interdependent.  
 
Making changes to contacts can impact the operation of channels that are configured 
to rely upon them. Contact Manager always makes the exact changes you specify, and 
automatically updates the codeplug's database to match. 
 
Be careful when enacting changes. You can easily "break" codeplugs! 



 
Viewing, Editing, and Adding Contacts 6 

 
 
 
 
 
 
 
 
 
2.2 Viewing Contact Information 
 
Once a valid codeplug file has been loaded, you may click the CONTACTS tab to see the 
contact information. 
 
If the codeplug has no contacts, you'll simply see the message "# No Contacts #" within this 
pane. 
 
2.3 Sorting Contacts 
 
In order to sort contacts, click on the header for the appropriate column; the contacts will be 
automatically sorted and redisplayed. In Figure 2, the header row DMR-MARC ID has been 
clicked, and as a result, the contacts list is now sorted in that order. 
 

 
Figure 2: Sorting on the DMR-MARC ID 

 
Sorting is a very handy method for locating all contacts of a certain type (Group, Private, or 
All Call), or locating contacts by name. 
 

NOTE: The RDT and RDB file formats do not include check information (such as a 
CRC), and it is possible for defective files to be loaded into Contact Manager. Contact 
Manager will warn you if it finds inconsistencies in the codeplug data. Incorrect data 
fields are always set to a default, safe value. 

NOTE: Sorting contacts changes the order they will appear in the codeplug and radio 
display. It has no other effect on the operation of the radio. 
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2.4 Editing Contacts 
 
There are two ways of invoking the contact editor: 
 

• Double-click the contact within the contact list; 
• Right-click within the contact list and choose "Edit..." from the pop-up menu. 

 
The Contact Editor dialog will appear as shown in Figure 3. 
 

 
Figure 3: Contact Editor 

 
 
Once you've made the necessary changes to the contact, click Apply to write the updated 
contact into the codeplug, or Cancel to discard the changes you've made. 
 
Note that duplicate DMR-MARC ID numbers are not permitted in the codeplug. Contact 
Manager enforces this relationship; if you attempt to change a contact's DMR-MARC ID 
number to one that already exists within the codeplug, the following error message will 
appear: 
 

 
 
 
It is permissible to have duplicate contact names for contacts that are of Private Call type. 
This situation may arise when a ham has two or more distinct radios, each with the same 
personal identifier (call sign, name) but a different DMR-MARC ID number. 
 
Contact names should not be duplicated for Group and All Call contacts, as this may cause 
the radio to use a wrong contact ID number when it makes an outgoing call. 
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2.5 Deleting Contacts 
 
To delete a contact, simply right-click the contact within the list and choose "Delete..." from 
the pop-up menu. Contact Manager will ask for confirmation before deletion: 
 

 
 
 
You can also delete groups of contacts by using SHIFT and/or CTRL clicks to highlight the 
desired set, then right-clicking within the contact list to bring up the context menu. 
 
 
2.6 Exporting and Importing Contacts from CSV Files 
 
To export all contacts to a CSV file for manipulation in other software, click the 
 Export All Contacts to a CSV File button. Contact Manager will write a plain text file with 
all contacts in the current codeplug. 
 
The format of exported contacts is as follows: 
 

• One line in the CSV file is used for each contact. All fields are wrapped in quotes. 
• The fields are DMR-MARC ID number, Contact Name, Contact Type, and Alert Tone. 
• Contact Type is either Private, Group Call, or All Call. Alert Tone is either Yes or No. 

 
 
 
 
 
 
 
The box above is an example of four exported contact records. 
 
Please note that internal to the radio, contacts are represented in 16-bit Unicode; Contact 
Manager only supports ASCII and converts between the Unicode and UTF-8 (ASCII) 
versions of the data when importing and exporting contact data. 

"99","Simplex","Group Call","No" 
"913","GROUP913","Group Call","No" 
"145210","TAC 21","Group Call","No" 
"145290","TAC 29","Group Call","No" 
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2.7 Importing Contacts from DMR-MARC 
 
DMR-MARC is a worldwide database of DMR users, and Contact Manager has built-in 
ability to look up information within this database. This is very handy when looking up new 
contacts, as it eliminates manual copying and retyping of information (along with the 
potential errors that go along with that). 
 
Your computer must be connected to the Internet for this feature to work. 
 
To search and import contacts from DMR-MARC, click the Import Contacts from DMR-
MARC Database button. The database search dialog of Figure 4, below, will appear. 
 

 
Figure 4: Database Search Dialog 

 
  
The STATUS PANE is contained within the upper right-portion of this window. It displays a 
progress indicator if the DMR-MARC connection is in progress, and "Database is ready for 
searching" when full connectivity has been established. 
 
If there is a problem with connecting to the DMR-MARC database, the status pane will 
display "Sorry, database not available." If you get this message, check your Internet 
connection. You will need to restart Contact Manager to retry the connection. 
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To locate contacts in DMR-MARC, simply type the search terms into the SEARCH 
INFORMATION box. Contact Manager will instantly populate the SEARCH RESULTS with 
all registered contacts that match your search criterion. 
 
In the example of Figure 4, the search term "United" was entered. This located all DMR-
MARC registrant records containing the string "United," which would pull in all US stations, 
plus others containing that string. (This particular search requires less than a second to 
complete!) 
 
Contact Manager uses a relaxed protocol for searching; it examines all fields for the 
information you request, and ignores the difference between upper and lower case letters. If 
you get too much information back from a search, simply add more information to the search 
string. 
 
Search strings must have at least three characters for searches to be carried out. 
 
Once the desired search results are displayed, they can be added to the contacts within the 
codeplug in three different ways: 
 

• Double-click the search result that you want to add to the codeplug's contacts. 
 

• Highlight the desired search results and click the Add Selected Records button. 
 

• Click the Add All Records button to add all the search results to the codeplug. 
 
Records being added to the contacts in the codeplug may be designated as Private, Group 
Call, or All Call by using the TYPE FOR ADDED RECORDS drop down box. Additionally, 
you may customize how the NAME field in the codeplug is populated by entering data within 
the NAME TEMPLATE: 
 

• In Figure 4, contacts will be named with the ham operator's call sign (%C), followed 
by a dash (-), and their first name (%F). 
 

• Any combination of format codes as shown in the dialog can be used to populate the 
NAME field. 
 

• The NAME field is limited to 16 characters. Excess characters are truncated when 
the contacts are added to the resident codeplug. 

 
When you are done adding records from DMR-MARC, simply click Done Searching to be 
returned to the program main window.  
 
If desired, contacts can be sorted and edited as usual in the main window after importing as 
described in Section 2.3.  

NOTE: Contact Manager waits up to 30 seconds to establish the DMR-MARC 
connection. It also tries all DMR-MARC host locations as defined in the current DNS 
records for the organization. Be aware that DMR-MARC is not guaranteed to be 
available 24/7, and during those periods, Contact Manager will be unable to connect 
with it. 
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2.8 Copy and Paste Operations with Contacts 
 
Contacts can be freely moved between codeplugs by using standard copy and paste 
commands within Contact Manager. To move selected contacts from one codeplug to another, 
proceed as follows: 
 

• Open two copies of Contact Manager. Open the source codeplug in one copy, and the 
destination in the other. (You may open as many copies of Contact Manager as your 
computer's memory allows - - there is no limit.) 
 
There is no limit to the number of copies of Contact Manager that you can open at 
one time, other than available memory in your computer. 
 

• In the source codeplug, highlight the desired contacts, then right-click within the 
contacts list to bring up the context menu. 
 
Choose "Copy" from this menu. The contacts are copied to the clipboard. 
 
TIP: You may also use the keyboard shortcut  CTRL - C as in other Windows 
programs. 
 

• In the destination codeplug, paste in the desired contacts using any one of these 
methods: 
 
1. From the Edit menu, select "Paste" to paste in the new contacts. 
 
2. Right click within the contacts list and select "Paste" from the context menu. 
 
TIP: You may also use the keyboard shortcut  CTRL - V  to paste information as in 
other Windows programs.  
 
TIP; It does not matter which tab is open in Contact Manager when pasting, the 
program will automatically paste the information into the correct tables in the 
codeplug. 

 
 
During a paste operation, Contact Manager checks for duplicate DMR-MARC ID numbers; if 
an incoming contact contains a duplicate number, it is automatically skipped. 
 
After a paste, Contact Manager reports the number of contacts added, as well as the number 
of duplicates skipped, if any. 
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2.9 Importing from Other Codeplugs 
 
Contact Manager allows contacts to moved en-masse from one codeplug to another without 
opening two copies of the program. 
 
If you want to pull all contacts from a different codeplug into the working codeplug, proceed 
as follows: 
 

• Open the working codeplug. 
• From the contacts pane, click the Import More Contacts from Another Codeplug 

button.  
• Contact Manager will open a file selection dialog box; choose the codeplug containing 

the contacts you want imported. 
• Click the Merge -> button in the file selection dialog box to complete the import. 

 
As with paste, Contact Manager will report how many contacts were imported, and will 
reject duplicate DMR-MARC ID numbers. 
 
 
 
 TIP: You may import contacts from any type of codeplug without restriction (RDB or 

RDT), regardless of what type of codeplug you're working with. This is handy for 
moving contact information between different series of radios. 
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3.0 Editing and Viewing Channels 
 
 
Contact Manager can be used to view, edit, and sort channels within any codeplug. To work 
with channels, click the CHANNELS tab in the main window; the display of Figure 5 will 
result. If there are no channels in the codeplug, "# No Channels #" will be displayed. 
 

 
Figure 5: Contact Manager in CHANNEL Mode 

 
Many, but not all, fields for channels are shown in the CHANNELS tab. For compactness, 
some fields serve a dual purpose; for example the field "T-Enc/Cnt" holds the CTCSS tone 
encode value for transmission on an FM channel, and the CONTACT value for a DMR 
channel. All fields are visible in channel edit mode. 
 

TIP: RDB Codeplugs (CS750/800) must have at least one channel. The last channel 
can't be deleted for this reason. 
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3.1 Sorting Channels 
 
Contact Manager will sort the channels in the codeplug when any column header of the 
channel list is clicked. This is useful for visualizing what channels are in the codeplug, as 
well as the frequency ranges and other dependent information. 
 
 
 
 
 
 
 
 
TIP: If you wish to sort channels to locate information, but don't want to make permanent 
changes, do not save changes to the codeplug when exiting the program (or opening another 
codeplug). 
 
3.2 Editing Channels 
 
To edit a channel, either double-click the channel, or right click on the channel and choose 
"Edit..." from the context menu. The channel editor dialog of Figure 6 will appear. 
 

 
Figure 6: Channel Editor Dialog 

 

IMPORTANT: Sorting channels changes the order they will appear in the codeplug 
and radio display. This enacts an organizational change to the codeplug's relational 
database structure that is fully accounted for by Contact Manager. It does NOT affect 
the operation of the channels or their membership in zones, scan lists, and so forth. 
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The channel editor allows manipulation of most channel parameters; simply use the drop-
down boxes and blanks to modify the information as required. 
 
Certain channel parameters unique to particular models are not displayed. For example, the 
"Personality" setting for CS750/800 (RDB) analog channels is not displayed. 
 
There are two tabs in the channel editor, DMR CHANNEL and FM CHANNEL. Digital 
channels channels will display with the DMR CHANNEL tab active, and FM channels will 
show the FM CHANNEL tab. 
 
 
 
 
 
 
Once you've made the desired changes to a channel, click the Save Changes button, or click 
Cancel to discard the changes. 
 
3.3 Adding Channels 
 
To add a new channel to the codeplug, right-click within the channel list to bring up the 
context menu, and choose "Add Channel..." from the menu. 
 
The channel editor of Figure 6 will again display; enter the information for the channel and 
click Save Changes to enter it into the codeplug. 
 
Channels are always appended to the end of the codeplug. To alter the position of a channel, 
sort the codeplug channels as desired. 
 
For RDB analog channels, undisplayed fields have the same default values as assigned by 
the CPS. 
 
3.3 Copy and Paste Operations with Channels 
 
Channels can be freely moved between codeplugs by using standard copy and paste 
commands within Contact Manager. For FM channels, only the channel data are copied; for 
DMR channels, Contact Manager also moves the appropriate DMR-MARC contact 
information. This happens automatically. 
 
To move selected channels from one codeplug to another, proceed as follows: 
 

• Open two copies of Contact Manager. Open the source codeplug in one copy, and the 
destination in the other. 
 

• In the source codeplug, highlight the desired channels, then right-click within the 
channels list to bring up the context menu. 
 
Choose "Copy" from this menu. The channels (and associated contact data elements, 
if needed) are copied to the clipboard. (You may also use CTRL - C to perform the 
copy.) 
 

IMPORTANT: Clicking the DMR and FM tabs changes the channel's type, and also 
changes the information that's displayed. Be careful! 
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• In the destination codeplug, paste in the desired channels using any one of these 

methods: 
 
1. From the Edit menu, select "Paste" to paste in the new channels, or type  
    CTRL - V. 
2. Right click within the channels list and select "Paste" from the context menu. 
 

 
During a paste operation, Contact Manager checks for duplicate channel names as well as 
duplicate DMR-MARC ID numbers in contacts. Duplicate DMR-MARC contacts are not 
imported. 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
After a paste, Contact Manager reports the number of channels and supporting digital 
contacts added, as well as the number of duplicates skipped, if any. 
 
TIP: You can create duplicates of channels within the same codeplug by simply doing a copy 
and paste. Contact Manager will prompt you for a distinct name for the newly-copied 
channel(s) (no two channels may share the same name). 
 

IMPORTANT: Contact Manger implements intelligent paste technology. When 
duplicate DMR-MARC ID numbers are detected, Contact Manager assigns the contact 
name for the incoming channel to the resident contact name in the target codeplug.  
 
As an example, suppose the channel being copied from the source codeplug uses a 
contact named "DIRECT" with a DMR-MARC ID of 99, but a contact named 
"SIMPLEX" with an ID number of 99 exists in the target (recipient, paste) codeplug. 
This would normally be an error; however, Contact Manger simply reassigns 
SIMPLEX as the digital contact value for the incoming channel. 
 
In this example, the contact named "DIRECT" is not imported at all and will not 
appear in the destination codeplug. It's not an error, and in fact will work perfectly in 
the target radio, as only the DMR-MARC ID number is important! 
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3.4 Importing Channels from Another Codeplug 
 
 
Contact Manager allows channels and associated digital to moved en-masse from one 
codeplug to another without opening two copies of the program. 
 
If you want to pull all channels from a different codeplug into the working codeplug, proceed 
as follows: 
 

• Open the working codeplug. 
• From the CHANNELS pane, click the Import From Codeplug... button.  
• Contact Manager will open a file selection dialog; choose the codeplug containing the 

channels you want imported. 
• Click the Ch Import -> button in the file selection dialog to complete the import. 

 
Contact Manager will report how many channels were imported, and will intelligently import 
and adjust related contact information for each channel as required. 
 
 
 
 
 

TIP: The source and destination codeplugs can be of any supported type, and do not 
have to be the same type at all. 
 
This can also be accomplished using the Structural Import feature described in 
Section 6. 
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4.0 Zone Management 
 
Controller Manager allows visualization and editing of zones within codeplugs. A zone is a 
special portion of the radio configuration that contains a set of channels, along with the scan 
lists and other data associated with each channel. Most radio types store 16 channels in each 
zone, however, this is not always the case. 
 
To work with zones, click the ZONES tab; the software will display the zone information as 
shown in Figure 7. 
 

 
Figure 7: Zone Mode 

 
 
The left list, "Channels in Zone," shows what channels are currently in the zone. The right 
list, "Master Channel List," always shows all available channels in the codeplug. 
 
The Master Channel List can be sorted for easier location of individual channels, if desired. 
The zone channels do not support sorting. 
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4.1 Selecting the Active Zone 
 
The radios supported by Contact Manager allow up to 250 different zones. To select the 
active zone, click the  and  buttons. 
 
 
4.2 Operations within a Zone 
 
Several options are available within each zone: 
 

• To add channels to the active zone, double-click the channel desired in the Master 
Channel List. They will be added to the channels in the left-hand zone content list. 
 
A zone will not hold more than 16 channels. Channels are placed into the zone in the 
order they are pulled from the Master Channel List, and cannot be sorted. 
 

• To remove channels from a zone, double-click them in the left-hand Zone Channel 
List; they'll be removed from the zone. 
 

• To rename a zone, click the Rename Zone button and type in the new name for the 
zone. 
 

• To copy a zone to the clipboard, click the Copy Zone  button. Conversely, if you've 
copied a zone to the clipboard and want to insert it into the codeplug, click the 
Paste Zone button. 
 

• To reorder items within a zone (which impacts the position at which they will be 
activated using the channel switch on the radio), highlight them, then click the or 

buttons to move them. Only one item may be moved at a time. 
 

• You can directly edit channels within a zone by right-clicking them, then choosing 
"Edit Channel. . ." from the pop-up menu. 
 

• Some radios include multiple channel banks in zones. For example, the MD9600 
stores two banks of 64 channels (128 total) in each zone. For radios with multi-bank 
zones, a button will appear showing which bank is being displayed and edited. This 
button will either appear as [A]<-- BANK   or   BANK-->[B] as shown in Figure 7. 
Click it to switch between active banks. This button appears only when a zone 
contains multiple banks, so for most radio types it will not be visible. 
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4.3 Adding and Removing Zones 
 
To add a new zone, click the [+] New Zone button. Contact Manager will prompt you for the 
name of the new zone, and a new zone with empty channels will be produced. 
 
To remove a zone, click the [-] Delete Zone button. Contact Manager will ask you for 
confirmation before removing the zone. 
 
 
 
 
 
 
 
 
 
 
 
 
4.4 Copying Zones Between Codeplugs 
 
It's easy to move zone data between two or more different codeplugs. As with copying channel 
data, Contact Manager intelligently pastes zone data: 
 

• When zone channels are moved into the destination codeplug, Contact Manager 
checks to see if the new zone is referencing existing channels. 
 
If the specified channel from the zone already exists, it is not copied into the 
destination codeplug. 
 
NOTE: Contact Manager uses the name of the channel to determine duplicity. This is 
not a guarantee of error-free operation, so you should verify zone data after pasting. 
 

• Whenever new channels are imported, Contact Manager automatically moves 
associated contact data as needed. 
 
Contacts use the DMR-MARC ID number as the primary key for duplicate checking; 
if an existing contact in the destination codeplug has the same primary key, that 
contact will automatically be substituted for the imported channel's contact name. 

 
 
 
 
 
 
 
 
 

TIPS:  
 
(1) Removing zones does not impact the channels stored in the codeplug (they are not 
deleted when a zone containing them is deleted.) 
 
(2) You can copy an existing zone, then paste it back into the same codeplug as a new 
zone. This is useful if you want to create a new zone that's derived from an existing 
one. 

TIP: To replicate a zone within a codeplug, simply issue a COPY on the zone you wish 
to duplicate, then immediately issue a PASTE command to Contact Manager. Contact 
Manager will prompt you for a new name for the duplicate zone, which you can then 
edit as desired. 
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4.4.1 Copying Zones of Differing Layout and Size 
 
Different types of radios may have zones with various layouts and sizes. Contact Manager 
always transfers as much data as possible during copy and paste operations, subject to the 
limitations of the source and destination codeplugs. 
 
A few examples will serve to clarify how this works: 
 
Scenario 1: A zone from an MD380 codeplug (16 channels) is copied into a CS800D codeplug 
(16 channels). 
 
Outcome: All sixteen channels are copied to the CS800D codeplug, as the two zones are 
dimensionally equal. 
 
 
Scenario 2: A zone from a MD2017 codeplug is copied, then pasted into an MD380 codeplug. 
This zone has 32 channels in the A portion, and 16 in the B portion. 
 
Outcome: Since the MD380 can only store 16 channels in a zone, the pasted zone will contain 
only the first 16 channels from the A portion of the MD2017 zone. The remaining channels in 
the A and B portions are not pasted into the MD380 codeplug. 
 
 
Scenario 3: A zone from a CS750 codeplug is copied, then pasted into an MD2017 codeplug. 
This zone has 16 channels. 
 
Outcome: Contact Manager will create a new zone in the MD2017 codeplug. The A-portion of 
the new zone will contain all 16 channels from the CS750, and the B-portion will be empty. 
 
 
 
Scenario 4: A zone from an MD2017 codeplug (containing a full 128 channels) is pasted into 
an MD9600 codeplug. 
 
Outcome: The two zones are dimensionally equivalent (two banks of 64 channels), so the zone 
will be identical when it's pasted into the MD9600 codeplug. 
 
 
 TIP: If you have many zones to move, it's better to employ the Structural Import 

feature - See Section 6 for details. 
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4.5 Reordering Zones within Codeplugs 
 
Contact Manager allows the order of zones to be adjusted within codeplugs. This feature 
makes it easy to optimize codeplug structure for best operational efficiency and 
understanding for end-users. 
 
To change the order of zones, click the Reorder. . . button under the Zones tab. The following 
dialog will appear as shown in Figure 8: 
 

 
Figure 8: Reorder Zones Dialog 

 
Within the Reorder Zones dialog, simply highlight a zone, then click the or buttons to 
move it to a different position in the codeplug.
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5.0 Scan List Management 
 
Controller Manager allows visualization and editing of scan lists. 
 
To work with scan lists, click the SCAN LISTS tab; the software will display the scan list 
information as shown in Figure 8. 
 

 
Figure 8: Scan List Mode 

 
 
The left list, "Channels in Scan List," shows what channels are currently in the scan list. The 
right list, "Master Channel List," always shows all available channels in the codeplug. 
 
The Master Channel List can be sorted for easier location of individual channels, if desired. 
The scan list channels in the left pane do not support sorting, however, you can use the  or 

buttons to re-order them as desired. 
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5.1 Selecting the Active Scan List 
 
The radios supported by Contact Manager allow up to 250 different scan lists. To select the 
active scan list, click the  and  buttons. 
 
TIP: The  and  buttons have alternate text of "previous group" and "next group" for 
those using vision assistive software. 
 
 
5.2 Operations within a Scan List 
 
Several options are available within each scan list: 
 

• To add channels to the active scan list, double-click the channel desired in the Master 
Channel List. They will be added to the channels in the left-hand scan list content 
list.  
 
A scan list will not hold more than 31 channels. Channels are placed into the scan 
list in the order they are pulled from the Master Channel List. 
 

• To remove channels from a scan list, double-click them in the left-hand Scan List 
Channel List; they'll be removed from the scan list. 
 

• To rename a scan list, click the Rename. . .  button and type in the new name for the 
scan list.  
 
TIP: Renaming a scan list has no operational impact on the codeplug - - Contact 
Manager automatically updates references to the scan list in all channels. 
 

• To reorder items within a scan list (which impacts the order that the radio searches 
them), highlight them, then click the or buttons to move them. Only one item 
may be moved at a time. 
 
TIP The and buttons have the alternate text of "move item up" and "move item 
down" for those using vision assistive software. 
 
 

• You can directly edit a channel in a scan list by right-clicking on it, then selecting 
"Edit Channel. . ." from the pop-up menu. 
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5.3 Adding and Removing Scan Lists 
 
To add a new scan list, click the [+] New Scan List button. Contact Manager will prompt you 
for the name of the new scan list, and a new empty scan list will be produced. 
 
To remove a scan list, click the [-] Delete Scan List button. Contact Manager will ask you for 
confirmation before removing the scan list. 
 
 
 
 
 
 
 
 
 
 
 
 

TIPS:  
 
(1) Removing scan lists does not impact the channels stored in the codeplug (they are 
not deleted when a scan list containing them is deleted.) 
 
(2) The current version of Contact Manager does not support copy and paste for scan 
lists. 
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6.0 Structural Import Concepts 
 
Contact Manager has the ability to work with multiple codeplug types, and by using the 
clipboard, information of various types such as contacts, channels, and zones can be freely 
copied between any open codeplugs.  
 
However, even with this capability, it can be tricky to move configuration data between 
codeplug types, as there are many data dependencies within codeplugs, as illustrated by 
Figure 9. 

Contacts Receive Groups 

Channels Scan Lists 

Zones 

Figure 9: Codeplug Data Dependencies 
 
 
Figure 9 illustrates the complex nature of the information within codeplugs. In the figure, 
arrows reflect the relationships between different areas of the codeplug. For example, the 
data held in digital contacts is needed by both channels (for the Tx Contact information) as 
well as receive groups (which contain lists of contacts). In turn, channels and scan lists are 
co-dependent (a channel may specify a scan list, and scan lists specify groups of channels), 
while zones depend upon channel data.  
 
It's a lot to keep track of, and fortunately, Contact Manager does this for you automatically; 
this is especially important when data are copied and pasted using the clipboard; Contact 
Manager's IntelliPaste technology works to keep related data together during these 
operations. 
 
Structural Import is designed to go a step beyond mere copy and paste. It allows mass-import 
of information between codeplugs of any supported type, and assures that all of the 
supporting data framework is inserted correctly so that the new codeplug will work correctly 
the first time, with no manual adjustments or "tweaking."  
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The format of the codeplugs makes no difference. Contact Manager automatically converts  
information to the correct format when inserting it into the destination codeplug. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6.1 Performing a Structural Import 
 
 
It's very easy to import the important information from another codeplug. Simply perform 
the steps as follows: 
 

• Open the codeplug that is to to be the recipient of the information in Contact 
Manager. 
 
TIP: We recommend that the information in the recipient codeplug be kept to a 
minimum. Conflicts of data fields (such as contact names, channel names, and so 
forth) will result in dropped information during the transfer. 
 
 

• Click the Structural Import Tab as shown in Figure 10. 
 
As you can see, we've created a blank CS800 (RDB) codeplug previously in the CPS. 
There is minimal information in this codeplug. 

 

WHY NOT DESIGN CONTACT MANAGER TO DIRECTLY CONVERT BETWEEN 
CODEPLUG FAMILIES? 
 
This is a good question, and in fact, is a fundamental design decision behind the 
software. This approach has been expressly avoided as there are too many variations of 
Customer Programming Software (CPS) used with various manufacturer's radios, each 
with many undocumented structural data nuances. We've found that it's possible to do 
this in a limited fashion within families (such as RDT), but it proves to be risky 
business when moving across platforms (RDT to RDB, for example, which isn't even a 
uniform standard). Therefore, Contact Manager requires a blank codeplug, generated 
by you for your own radio, in order to work with the data.  
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Figure 10: Structural Import Tab 
 
 
 

• Within the Structural Import tab, select the data elements that you wish to import. 
All the elements are checked by default. 
 
TIP: Remember that these items are dependent upon each other. If you uncheck 
"Group/All Call" contacts, for example, any channels that rely upon a group or all call 
contact will be transferred with empty contact information - - and probably won't 
work! 

 
• Click the Import Selected Structures. . .  button and choose the donor (source) 

codeplug, which can be of any type, as shown in Figure 11. 
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Figure 11: Choosing the Donor Codeplug for Structural Import 
 
You can see that we're going to pull in all the data from an MD380 (RDT) codeplug. 
Our CS800 codeplug will have exactly the same contacts, channels, and zones as the 
donor MD380. 
 
Click the Import > button to begin importing the information. 
 

 
Once you've clicked Import >, Contact Manager will move the information into the open 
codeplug. A brief summary of what has been imported will be displayed: 
 

 
 
 
In this instance, we have moved all the data from NØGSG's MD380 codeplug into a CS800 
codeplug. The CS800 will have all the contacts, receive groups, channels, scan lists, and 
zones provided by the MD380 codeplug, and they'll be organized identically. 
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6.2 How Conflicting Information is Handled During Import 
 
Contact Manager does its best to cleanly import information, however, there are some 
situations that will cause data elements to be omitted or modified: 
 

• Duplicate contact (NAME and DMR-MARC ID are both identical): The contact is not 
imported as it already exists in the CONTACTS table. 
 

• Duplicate channel name: The channel is not imported. When determining duplicity 
for a channel, only the name is examined - - the frequency data are not compared. 
 

• Duplicate receive groups: These are simply imported and will appear as duplicates 
within the codeplug. No harm is done, but future releases of Contact Manager will 
probably address this differently. 
 

• Duplicate scan lists: Duplicates will be imported and will have a number (1, 2, etc.) 
appended to their name to show that they're duplicates. 
 

• Duplicate zones: Duplicates will be imported and will have a number (1, 2, etc.) 
appended to their name to show that they're duplicates. 
 
Upper and lower case letters appear the same to Contact Manager when comparing 
name information in each data field. 
 

TIPS:  
 
1. You can aggregate the structural information from multiple codeplugs if desired. 
Just repeat the procedure above for each codeplug that you wish to import data from. 
Remember that conflicting information (such as duplicate channel names and contacts) 
may cause problems, so carefully evaluate this information before splicing multiple 
codeplugs together. 
 
2. If you're working with codeplugs with many contacts (tens of thousands), it may take 
a few seconds for the import operation to complete. This is normal.



 

 

Structural Import across Codeplug Types 31 

 
• Incompatible zone dimensions: Contact Manager uses the rules described in Section 

4.4.1 to transform zones as they are moved between codeplugs of different types. As 
an example, it's physically impossible for a recipient codeplug with 16 channels per 
zone to store data from a source zone that contains 48 channels. 
 
When doing a Structural Import, all of the source codeplug channels are always 
transformed and moved, even when the zones are not compatible, assuming that 
you've asked Contact Manager to transfer the channel data.  
 
The same is not true when a simple copy and paste is executed on zones. What this 
means is that even if the zones do not not transfer completely due to the limitations 
of the destination codeplug format, you still have all the channels and and associated 
contacts available in the destination codeplug - - information that will allow you to 
quickly and easily construct appropriate new zones containing the necessary 
channels. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

WEIRD DUPLICATES (THAT YOU MAY NOT EXPECT) 
 
Some codeplug formats compress character strings (such as the names of channels and 
contacts) in bizarre ways. Before checking for duplicates, Contact Manager first 
determines if the destination data field is compressed, and if so, what method of 
compression (lossless or lossy) has been used. 
 
Two key examples of this are contact and channel names in RDB (CS750/800/800D) 
codeplugs. Lossy compression is used for these fields, and as a result, the only 
punctuation allowed is the space and period. Therefore, Contact Manager considers the 
following contact names exactly equal when importing information into an RDB 
codeplug: 
 

• "Bill-WAØCBW" 
• "Bill*WAØCBW" 
• "Bill.WAØCBW" 

 
In an RDB codeplug, all of these will be compressed as "Bill.WAØCBW " as the period is 
the only punctuation allowed. Therefore, these are all duplicate names! 


